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Konoz

A Guide to Next-Generation Financial Operations

The comprehensive guide to building, managing, and scaling your own financial
ecosystem with the Konoz Financial Operations & Wallet Management System
for WordPress.

https://konoz.it-realms.com
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Foreword

Welcome to the definitive guide for the Konoz Financial Operations & Wallet Management System — a WordPress plugin that
transforms any website into a fully functional financial services platform. Whether you are a startup founder launching a
digital wallet, an enterprise architect designing a corporate expense management system, or a community leader building a
microfinance institution, Konoz provides the infrastructure to turn your vision into reality.

This guide is more than a technical manual. It is a comprehensive companion designed to take you from your very first
installation to the confident management of a thriving financial ecosystem. Every chapter has been crafted to provide not
only the how, but also the why — the strategic thinking behind each feature, the best practices that separate good platforms
from great ones, and the real-world use cases that illustrate what is possible.

You will discover how to configure a secure, branded platform; how to onboard customers with regulatory-grade KYC
verification; how to offer virtual cards, flexible loans, and structured savings products; and how to monitor every transaction
with the precision and transparency that modern financial services demand.

The Konoz team has poured years of financial technology expertise into this platform. This guide distills that knowledge into a
clear, actionable resource that respects your time while ensuring you miss nothing important. We invite you to explore it at
your own pace, and we are confident that by the final page, you will see the extraordinary potential that Konoz places in your
hands.

The Konoz Team
Realms Information Technology

QUICK START

Launch Your Financial Platform in 10 Minutes

This accelerated guide takes you from a fresh WordPress installation to a fully operational financial platform. Follow these five
steps to experience the core capabilities of Konoz immediately, then explore the detailed chapters at your own pace.

i PREREQUISITES

Before you begin, ensure you have: WordPress 5.8+ installed on a PHP 7.4+ server with MySQL 5.7+, the Konoz plugin ZIP file
(available from konoz.it-realms.com), and administrator access to your WordPress dashboard. A valid SSL certificate (HTTPS)
is required for production payment processing.

a Install & Activate the Plugin
Navigate to Plugins > Add New > Upload Plugin in your WordPress admin panel. Select the Konoz ZIP file and click Install
Now, then Activate. The Konoz menu will appear in your admin sidebar immediately. If you encounter a memory limit error,
increase your PHP memory limit to at least 256MB in your wp-config.php file by adding define('WP_MEMORY_LIMIT',
'256M'); .

- Full installation details in Chapter 2

a Load Demo Data & Explore

Navigate to Konoz > Demo Data and click Load Demo Data. This populates your platform with sample accounts (John Doe
and Jane Smith), transactions, and financial products — giving you a realistic environment to explore without risk. Log in as
John Doe (credentials provided on the demo data page) to experience the customer dashboard firsthand.

- Demo data details in Chapter 2, Section 2.3
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Configure Your Brand & Currency

Navigate to System Settings > General to set your default currency (e.g., USD, EUR, AED). Then go to the Branding tab to
upload your logo and set your platform name. These settings propagate across every customer-facing interface, email
notification, and administrative report. For example, setting the currency to AED with the symbol “|.a" instantly localizes all

financial displays for a UAE-based platform.

- Full configuration guide in Chapter 5

o Create Your Customer-Facing Pages

Create WordPress pages for each core feature and add the corresponding shortcode. At minimum, create these four essential

pages:
PAGE NAME SHORTCODE PURPOSE
Dashboard [dfms_transactions] Customer home with balance, transactions, and quick actions
Register [dfms_register] New customer registration with KYC document upload
Transfer Money [dfms_transfer] Send money to other accounts or saved beneficiaries
My Cards [dfms_my_cards] View and manage issued virtual cards

- Complete shortcode reference with 20+ options in Chapter 12

e Fund the System Wallet & Go Live
Navigate to System Wallet and click Inject Capital to add initial funds. In Sandbox mode, this is instant and risk-free. For
Production, configure your payment gateway (System Settings > Payment Gateway) with your Stripe or PayPal API
credentials, then switch the wallet to Production mode. Your platform is now ready to accept real customers and process live
transactions.

- System Wallet management in Chapter 3; Payment gateway setup in Chapter 5

TIP — YOUR FIRST 24 HOURS

After completing these five steps, spend time exploring the demo data environment. Log in as both an administrator and a
demo customer to understand both perspectives. Try processing a KYC approval, issuing a virtual card, and disbursing a loan.
This hands-on exploration will give you the confidence to customize the platform for your specific use case. When you are
ready, delete the demo data and begin onboarding real customers.

READING GUIDE

Role-Based Reading Paths

Different roles interact with Konoz in different ways. Use the reading paths below to navigate directly to the chapters most
relevant to your responsibilities. Each path is designed to give you the knowledge you need in the most efficient order.

% = [ ]

Platform Administrator Business / Branch Manager End Customer

You install, configure, and maintain the You oversee daily operations: processing You use the platform to manage your

entire Konoz platform. You manage the customer registrations, reviewing KYC personal finances: viewing your dashboard,
System Wallet, configure payment documents, approving loan and card sending transfers, tracking expenses,
gateways, set up fraud detection rules, applications, monitoring transaction applying for virtual cards and loans, and
define financial product templates, and volumes, and managing customer building savings through DPS and FDR
ensure the platform runs securely and relationships. You need operational fluency products.

efficiently. without deep technical knowledge. Priority: Ch 6-8, 9-11 » Reference:

Priority: Ch 1-5, 12-14 * Then: Ch 9-11 Priority: Ch 3-4, 6-11,13 « Then: Ch 14 Glossary



i NOTE — HOW TO USE THIS GUIDE
While the reading paths above provide efficient routes for specific roles, we recommend that all readers begin with the Quick
Start guide and Part I: Foundations to establish a solid understanding of the platform’s architecture and philosophy. The
chapters are designed to be read sequentially, but each chapter is also self-contained enough to serve as a standalone

reference when you need to revisit a specific topic.
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PART |

Foundations

Every great financial platform begins with a solid foundation. Part | introduces the Konoz ecosystem, walks you through
installation and initial configuration, and ensures your environment is ready for the chapters ahead. By the end of this
section, you will have a fully operational Konoz instance with demo data loaded and ready to explore.

CHAPTER 1

Introduction to Konoz

What Is Konoz?

Konoz is a comprehensive financial operations and wallet management system built as a WordPress plugin. It transforms any
WordPress website into a fully functional financial services platform — complete with digital wallets, fund transfers, virtual
cards, lending products, savings instruments, expense management, and regulatory-grade KYC verification. The name
"Konoz" (jgi4) means “treasures” in Arabic, reflecting the platform’s mission to unlock financial potential for organizations and
their customers.

Unlike traditional banking software that requires millions in licensing and years of implementation, Konoz delivers enterprise-
grade financial capabilities through the world’s most popular content management system. This means you can launch a
financial platform with the same ease as launching a WordPress website — but with the sophistication of a modern fintech
solution.

The Konoz Ecosystem at a Glance

Konoz is organized into six interconnected capability domains, each designed to address a critical dimension of financial
operations. Together, they form a complete ecosystem that covers everything from basic wallet management to sophisticated
investment products.

CAPABILITY
DOMAIN

WHAT IT PROVIDES KEY FEATURES

Wallet & Accounts Digital wallet infrastructure Multi-currency wallets, account provisioning, balance management, sandbox/
production modes

Payments & Money movement Internal transfers, beneficiary management, deposits via Stripe/PayPal,
Transfers scheduled payments
Virtual Cards Digital card issuance Visa/Mastercard branded cards, spending limits, cashback, annual fees,

template-based design

Lending Loan origination & Loan templates, EMI calculation, disbursement, repayment tracking, eligibility
management validation

Savings & Wealth-building products DPS (recurring deposits), FDR (fixed deposits), maturity calculations, early

Investments withdrawal

Intelligence & Platform protection & Fraud detection (5 rules), KYC verification, role-based access, expense

Security insights analytics, budgeting



Who Should Use Konoz?

Konoz is designed for any organization that wants to offer financial services to its community, customers, or employees. Its
flexibility makes it suitable for a remarkably wide range of applications:

e Digital banks & neobanks seeking rapid market entry e Fintech startups building MVP products

o Microfinance institutions serving underbanked e Community organizations running savings programs

communities o Educational institutions managing student financial

o Cooperatives & SACCOs managing member savings and services

loans e Freelancer platforms providing payment wallets

e Corporate treasury departments managing employee
expenses

USE CASE — FROM CONCEPT TO LAUNCH IN 48 HOURS

A fintech startup in Lagos needed to launch a digital wallet for marketplace vendors. Using Konoz, they installed the plugin on a
managed WordPress host, configured branding and KYC requirements, created virtual card templates, and onboarded their first
50 vendors — all within 48 hours. Within three months, the platform processed over $200,000 in transactions with zero
security incidents, thanks to Konoz's built-in fraud detection and role-based access controls.

Architecture & Technical Foundation

Konoz is built on a robust technical foundation that leverages WordPress's extensibility while maintaining the security and
performance standards required for financial operations.

COMPONENT TECHNOLOGY PURPOSE

Platform WordPress 5.8+ with PHP 7.4+ Content management, user authentication, plugin architecture
Database MySQL 5.7+ / MariaDB 10.3+ Transaction ledger, account data, financial product records
Payment Processing Stripe & PayPal APIs Real-money deposits and payment collection

Security SSL/TLS, 2FA, role-based access Data encryption, authentication, authorization

Mobile Progressive Web App (PWA) Native-like mobile experience without app store distribution
Communications Twilio, Nexmo, Custom SMS Transaction notifications, balance alerts, announcements

CHAPTER 2

Installation & First Steps

System Requirements

Before installing Konoz, verify that your hosting environment meets the following minimum requirements. These
specifications ensure optimal performance and security for financial operations.



REQUIREMENT MINIMUM RECOMMENDED

WordPress 5.8 6.0+ (latest stable)

PHP 7.4 8.1+ for best performance

MySQL 5.7 8.0+ or MariaDB 10.5+

PHP Memory Limit 128MB 256MB or higher

SSL Certificate Required for Production Let's Encrypt or commercial CA
Max Upload Size 10MB 32MB (for KYC document uploads)

Installation Process

ﬂ Download the Plugin: Obtain the latest Konoz plugin ZIP file from konoz.it-realms.com or your authorized reseller.

Upload to WordPress: In your WordPress admin panel, navigate to Plugins > Add New > Upload Plugin. Click Choose
File, select the Konoz ZIP, and click Install Now.

admin sidebar.

e Activate the Plugin: After installation completes, click Activate Plugin. The Konoz menu will appear in your WordPress

Verify Installation: Navigate to Konoz > Dashboard to confirm the plugin is active. You should see the main dashboard
with zero accounts and transactions.

A IMPORTANT — PERMALINK CONFIGURATION

After activation, navigate to Settings > Permalinks and ensure the structure is set to Post name (or any option other than
“Plain"). Click Save Changes to flush rewrite rules. This step is essential — without it, Konoz's frontend pages will return 404
errors. This is the single most common post-installation issue.

Post-Installation Setup Checklist

After successful installation, complete the following configuration steps in order. Each step builds on the previous one,

ensuring a logical and complete setup.

[ ]
v

L J
v
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Set your default currency — System Settings > General — Choose the currency code (e.g., USD, EUR, AED) and symbol that will
be used across all financial displays and calculations. - Ch. 5

Upload your brand logo and set platform name — System Settings > Branding — Your logo appears on the customer dashboard,
login page, and all communications. - Ch. 5

Configure staff roles and permissions — User Management > Roles — Define what each staff role (Admin, Manager, Teller,
Support) can access. Apply the principle of least privilege. > Ch. 4

Enable fraud detection rules — System Settings > Fraud Detection — Activate all five detection rules (Velocity, Amount Anomaly,
Time Pattern, Recipient Pattern, Geographic Anomaly). > Ch. 5

Configure payment gateway — System Settings > Payment Gateway — Enter your Stripe or PayPal API credentials. Test with
sandbox keys first. > Ch. 5

Create customer-facing pages with shortcodes — Create WordPress pages for Dashboard, Registration, Transfer, Cards, Loans,
DPS, FDR, and Expenses. - Ch. 12

Fund the System Wallet — System Wallet > Inject Capital — Add initial funds to enable loan disbursements and DPS/FDR maturity
payouts. - Ch. 3

Set up communications — Communications — Configure SMS provider, auto-statements, and balance alert thresholds. - Ch. 5

Loading Demo Data

Konoz includes a built-in demo data generator that populates your platform with realistic sample data, allowing you to explore

every feature without risk. This is invaluable for training, testing, and stakeholder demonstrations.


https://konoz.it-realms.com

B e Dashboard

X Dismiss

Welcome to WordPress!

Learn more about the 6.9.1 version

Q7 Media

B Pages

¥ Comments
0z Dashboard

Bl System Wallet

9 Loans e i thor rich content with Customize your entire site Switch up your site’s look &

g Virtual Cards bcks and patterns with block themes feel with Styles

Multi-Currency

Financial Produdts  Analytics ; pat e pre-configured block Design everything on your site — from weak your site, or give it a whole new
hem to get inspired or the header down to the footer, all using

how about a new
i#f User Management Der & te new pages in a flash, blocks and patterns. 7

Communications

System Settings

Dashboard Konoz Demo Data

L Konoz Internal System Notice: This system creates internal digital accounts for use within your platform cnly. These are NOT payment cards and cannct be used for external purchases.

] Media

Pages
Comments Install Demo Data

Click the button below to install sample data induding

3 Demo customer acco vith wallets

sample transactions history

5 Virtual Card Templates (visa & Mastercard tiers)

3 Loan Templates (Pers

al Home, Business)

2 Virtual cards for demo user

* 1Activel,

with payment schedule
* 1DPS (Monthly savings plan)
* 1FDR (Fixed deposit)

Demo Data * System Wallet with $800,000 balance

B System Wallet Note: Dama data uses fictional information and can be removed anytime.

$) Lloans
Figure 2.1— The Demo Data page lets you populate your platform with sample accounts, transactions, and financial products for risk-free
exploration.

The demo data creates two sample customer accounts — John Doe and Jane Smith — each with pre-loaded wallet balances,
transaction histories, virtual card applications, loan records, and DPS/FDR accounts. This gives you a complete, realistic
environment to explore every feature of the platform.

TIP — EXPLORING BOTH PERSPECTIVES

After loading demo data, open two browser windows: one logged in as an administrator and one logged in as John Doe (demo
customer). This side-by-side view lets you see how administrative actions (approving a loan, issuing a card) immediately reflect
in the customer experience. It is the fastest way to understand the complete platform workflow.

A COMMON MISTAKE

Forgetting to delete demo data before going live with real customers. Demo accounts and transactions will appear alongside
real data, creating confusion and potential compliance issues. Always use the Delete Demo Data button in Konoz > Demo Data
before switching to Production mode and onboarding real customers.




@ Part I Summary
KEY TAKEAWAYS

e Konoz transforms WordPress into a complete financial services
platform with six capability domains

o Installation requires WordPress 5.8+, PHP 7.4+, and MySQL
5.7+ with SSL for production

@ The post-installation checklist ensures a logical, complete
setup in eight steps

e Demo data provides a risk-free environment with two sample
accounts for exploration

e Permalink configuration to “Post name" is essential to prevent
404 errors

WHAT YOU CAN DO NOW

¢ Install and activate Konoz on your WordPress site

o Load demo data and explore the platform as both admin and
customer

o Complete the 8-step post-installation checklist

Create your first customer-facing pages with shortcodes

e Proceed to Part Il to master the administrative core
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Dashboard

PART 11

The Administrative Core

Behind every seamless customer experience lies a powerful administrative engine. Part Il takes you deep into the
command center of your Konoz platform — the System Wallet, user management, KYC verification, security configuration,
and communications. Mastering these tools is essential for running a secure, compliant, and efficient financial operation.

CHAPTER 3

The Command Center: System Wallet & Dashboard

Understanding the System Wallet

The System Wallet is the central financial hub of your entire Konoz platform. Every financial operation — from loan
disbursements and DPS maturity payouts to deposit processing and capital withdrawals — flows through this wallet. Think of
it as the treasury of your digital financial institution: if the wallet runs dry, all outbound financial operations halt. Access it by
navigating to System Wallet in the admin sidebar.

R i System Wallet Dashboard

A Posts

o,] Media

Konoz Internal System Notice: This system creates internal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for external purchases.

Pages

Comments

ili Konoz

@ System Wallet © sandbox Mode Active: Al transactions are for testing only. Switch to Production for real money operations

Dashboard

- - B view Full Ledger ‘ @® Manage Wallets ‘ ‘ il Financial Reports ‘ ¥ Export Ledger ‘ © Inject Capital — Withdraw Capital
Ledger Transactions

Figure 3.1— The System Wallet dashboard provides a real-time view of your platform'’s financial position, including balance overview, mode toggle,

and quick actions.

DASHBOARD
DESCRIPTION WHY IT MATTERS

ELEMENT

Balance Overview Displays Production Balance, Sandbox Balance, and Instant financial health assessment at a glance
Total Balance

Wallet Mode Toggle Switch between Sandbox (testing) and Production (live) Separates test operations from real financial
transactions

Quick Actions Inject Capital, Withdraw Capital, Export Report Immediate access to the most common treasury
operations

Recent Transactions Latest 10 ledger transactions Quick anomaly detection without navigating to full
reports

Dashboard Statistics Total transactions, today's volume, active users Real-time platform activity monitoring

Sandbox vs. Production Mode

Konoz operates in two distinct modes, allowing you to test configurations safely before going live. Understanding the
differences is critical before accepting real customer funds.

"



FEATURE SANDBOX MODE PRODUCTION MODE

Purpose Testing and development Live environment with real funds

Capital Injection Manual injections allowed (instant) Manual injections disabled for integrity
Deposits Instant, no payment gateway required Requires configured Stripe or PayPal

Risk Level Zero — no real money involved Full — real financial transactions

Data Persistence Can be reset with demo data tools All transactions are permanent and auditable

A IMPORTANT — PRODUCTION READINESS

Always complete thorough testing in Sandbox mode before switching to Production. Once in Production, manual capital
injections are disabled to maintain financial integrity. All deposits must flow through configured payment gateways. Verify your
payment gateway credentials, fraud detection rules, and staff permissions before making the switch. - See Chapter 5 for

payment gateway configuration.

Key Wallet Operations

a Inject Capital: Click Inject Capital, enter the amount, reference number, and description, then confirm. Funds are
immediately available. Always record a meaningful reference number (e.g., "INV-2025-001") for audit trails.

a Withdraw Capital: Click Withdraw Capital, enter the amount and details, then confirm. This removes funds from the
system wallet. Use this for profit extraction or fund reallocation to external accounts.

a Export Report: Generate a comprehensive financial report filtered by date range. Use this for monthly reconciliation,
auditing, and compliance reporting. Reports export as CSV for easy import into accounting software.

System Wallet Submenus
Beyond the main dashboard, the System Wallet provides three specialized submenus for deeper financial management:
SUBMENU PURPOSE KEY FEATURES

Ledger Complete transaction history Filtering by date, type, and search term; CSV export capability
Transactions

User Wallets Individual customer wallet View all customer balances, statuses, and individual transaction
management histories
Reports Financial analytics Reports by date range, transaction volume analysis, and trend
monitoring
The Main Dashboard

The Main Dashboard provides a comprehensive, bird's-eye view of your entire financial ecosystem. Access it via Konoz >
Dashboard. At a glance, you can monitor the key performance indicators that matter most: Total Accounts and Active
Accounts to understand your customer base, Total Balance showing the aggregate value across all user wallets, and Total
Transactions with Today's Transactions to monitor platform activity in real time.

12



Dashboard

Good Evening, SALAH.ALMARDI!

Available Balance

@ $98,000.00 s ' B! ®

A/C: ACCABA24D3EG3

Quick Actions Recent Transactions View All

E a 2 card Expense : o
A eb 12, 2026 452 P
DPS

Expenses Manager Cards Loans

N -$2,000.00

B
¥ :c;a,’d B(pense - -$6,000.00

FDR Transfer
* lfanQ@r ment +$50,000.00
® :c;a,r“fpr, - +$15,000.00

Figure 3.2 — The Main Dashboard provides a bird's-eye view of your platform's key performance indicators.

TIP — DAILY OPERATIONS ROUTINE

Make the Main Dashboard your daily starting point. A quick review of today’s transaction volume and active account count
gives you an immediate pulse on platform health. Combine this with a System Wallet balance check to ensure you have
sufficient funds for the day's loan disbursements and maturity payouts. Establish a morning routine: Dashboard - System
Wallet - Pending Applications = Fraud Alerts.

CHAPTER 4

Mastering User & Account Management

Accounts Management

The Accounts section is your central hub for managing every customer wallet on the platform. Here you can view all

accounts, monitor balances, and take administrative actions on individual accounts. Navigate to Konoz > Accounts to access

the full account management interface.

© 2025 Realms Information Technology — All rights reserved \ https://konoz.it-realms.com
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@ Dashboard
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# Posts
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B Pages
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ACCT2A5348C7 ane Doe ane demo@example.com st 00 0 Active Feb 12, 2026 .
ACCTFAD196E1 John Smith johndemo@example com $25 0 10 = ‘:” "

Figure 41— The All Accounts view displays every customer wallet with balance, status, transaction count, and creation date.

ﬂ View the Account Table: Each row displays the account number, username/email, current balance, transaction count,
status (Active/Suspended), and creation date. Use the search bar to quickly locate specific accounts.

a Add a New Account: Click Add New Account, select an existing WordPress user, enter an initial balance, and the
account is created instantly. This is useful for manually onboarding VIP customers or staff accounts.

e Manage Account Status: Toggle any account between Active and Suspended states. Suspended accounts cannot
perform transactions until reactivated. Use suspension for compliance holds, fraud investigations, or customer requests.

i NOTE
Account statistics at the top of the page — Total Accounts, Active Accounts, and Total Balance — update in real time as you

manage accounts, giving you an always-current snapshot of your customer base. These same metrics appear on the Main
Dashboard for at-a-glance monitoring.

Beneficiaries

The Beneficiaries section provides a centralized list of all saved transfer recipients across the platform. Each beneficiary
record shows the associated user and the beneficiary’s account details, enabling administrators to audit and manage the
transfer network. This is particularly useful for compliance monitoring and identifying unusual transfer patterns. - See Chapter

7 for the customer transfer experience.

Roles & Permissions

Konoz implements a granular, role-based access control system that allows you to assign specific platform permissions to
WordPress user roles. This ensures that each team member has access only to the features they need — a critical principle
for financial platform security known as the Principle of Least Privilege.



Dashboard Roles & Permissions

Posts.

I Konoz Internal System Notice: This creates interal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for extemal p

Pages

Admin Permissions

Comments
_ Accounts Management

Konoz

ystem Wallet ‘ View Account

B Virtual Cards Support
Transactions
Financial Products

@ User Management: View

Users

Users Edit Users

Communications Staff & Roles

B System Settings ; ;
ew Staff Manage Staff

# Appearance Manage Roles

% Plugins

Reports

Figure 4.2 — The Roles & Permissions panel lets you define exactly what each staff role can access across six permission groups.

Konoz provides four built-in internal account types: Admin, Manager, Teller, and Support. Each can be configured with a
unique combination of permissions from the following groups:

PERMISSION GROUP PERMISSIONS RISK LEVEL RECOMMENDED ROLES
Accounts Management view_accounts, edit_accounts, delete_accounts Medium Admin, Manager
Transactions view_transactions, approve_transactions High Admin, Manager, Teller
Users view_users, edit_users Medium Admin, Manager, Support
Staff & Roles view_staff, manage_staff, manage_roles High Admin only

Reports view_reports, export_reports Low All roles

Settings manage_settings Critical Admin only

A COMMON MISTAKE

Granting manage_settings permission too broadly. This permission controls access to payment gateway credentials, fraud
detection rules, and branding. A compromised account with this permission could redirect payment flows or disable security
rules. Restrict it to senior administrators only, and audit permission assignments weekly.

Registration & KYC Verification

Konoz provides a complete customer onboarding pipeline with built-in Know Your Customer (KYC) verification. When
customers register through the frontend form (using the [dfms_register] shortcode), their applications appear in the admin
panel for review.

15



@ Dashboard Customer Registrations

Konoz Internal System Notice: This system creates interal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for external purchases.

D Name Emai Phone Location Date Applied

Abu Dhabi, UAE Feb 13

n Tom Micheal

» Appearance

£ Puugins

Statu:

Figure 4.3 — The Registration panel shows pending applications with full KYC document review capabilities.

Processing a customer registration follows a clear, auditable workflow:

a Review the Application: Click View on a pending application to see the applicant’s personal information and uploaded

KYC documents (ID Front, ID Back, Selfie, Address Proof).

a Verify Documents: Confirm that the ID photo matches the selfie, the name matches across documents, and the address

proof is current (typically within 3 months).

e Approve or Reject: Click Approve KYC Documents to verify the customer, or Reject KYC to decline with a stated reason.

Rejected customers may resubmit with corrected documents.

0 Automatic Provisioning: Upon approval, the system automatically creates a WordPress user account, generates login

credentials, creates a wallet account, and records the KYC verification timestamp.

2 Applicant Information KYC Documents

Tom Micheal m 1D Back Selfie Address

Tom@mail.com + Download

56465465

Figure 4.4 — A successfully approved KYC application showing the verified status and provisioned account details.

REGISTRATION us MEANING NEXT ACTION

Pending Awaiting administrative review of KYC documents Review and approve/reject within 24 hours

Approved KYC verified, account provisioned

Rejected Application declined with stated reason

Customer receives credentials via email

Customer may resubmit with corrected documents




Customer Onboarding Flow

User Registration

Account Created

I< I

KYC Document Upload

Admin Review

Approved Rejected

KYC Verified Resubmit Documents

Walllet Activated

First Deposit

Access All Services

Figure 4.5 — The complete customer onboarding process from registration through KYC verification to account activation.

¥ USE CASE — MICROFINANCE INSTITUTION

A microfinance company in East Africa uses Konoz's KYC pipeline to onboard rural customers. Field agents help customers
photograph their national ID and submit applications via mobile. The head office reviews and approves applications within

Within six months, the institution onboarded 3,000 new customers and reduced administrative costs by 60%.

CHAPTER 5

hours, enabling same-day account activation and loan eligibility — a process that previously took two weeks with paper forms.




System Configuration & Security

System Settings Overview

The System Settings panel is the nerve center for platform-wide configuration. Access it via System Settings in the admin

sidebar. The settings are organized into clearly defined tabs for efficient management.

SETTINGS TAB CONFIGURATION OPTIONS IMPACT

General Settings Default currency code and symbol Affects all financial displays and calculations
PWA Settings Enable Progressive Web App mode and app name Mobile app-like installation for customers
Branding Platform name and logo Customer-facing identity across all interfaces
Fraud Detection Enable and configure detection rules Transaction security monitoring

Payment Gateway Stripe and PayPal API credentials Required for Production deposits

About & Support Plugin version, author, license Reference information

Branding Your Platform

First impressions matter. The Branding tab allows you to set your platform’s name and upload your official logo, ensuring a

consistent, professional identity across every customer touchpoint — from the dashboard to email notifications.

@

Dashboard Konoz SettingS

[ . ,
o Konoz Internal System Notice: This system creates internal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for external purchases.

Media

Pages General Settings PWA Settings Branding Fraud Detection Payment Gateway About & Support

Comments
Platform Branding

i Konoz

Customize your platform name and logo for a personalized experience.
stem Wallet

Platform Name

appear throughout the system

Figure 51 — The Branding settings let you customize the platform name and logo for a professional identity.

Payment Gateway Configuration

For production environments, you must configure at least one payment gateway to process real customer deposits. Konoz

supports both Stripe and PayPal with full APl integration.



L Konoz Settings

Konoz Internal System Notice: This system creates internal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for external purchases.
General Settings ~ PWA Settings | Branding = Fraud Detection  PaymentGateway  About & Support

Payment Gateway Settings

P Virtual Cards (1] $0.00 0 0

Financial Products
r Management
mmunications Stripe
B System Settings
~r .
# Appearance Test Mode @ b
Plugins
Live API Key (e

Live Secret Key [ 2 live ]

Figure 5.2 — Configure Stripe or PayPal credentials to enable live payment processing.

ﬂ Select your gateway: Choose Stripe, PayPal, or both from the Payment Gateway tab.
a Enter API credentials: Provide your Publishable Key and Secret Key (Stripe) or Client ID and Secret (PayPal).

e Test the connection: Use sandbox/test credentials first to verify the integration before switching to live keys.

A IMPORTANT — API KEY SECURITY

Never expose your Secret Key or Client Secret in frontend code, emails, or shared documents. Store production API credentials
only in the Konoz settings panel, which encrypts them at rest. If you suspect a key has been compromised, rotate it immediately
in your Stripe or PayPal dashboard and update the Konoz settings. Consider enabling IP whitelisting in your payment provider's

dashboard for an additional layer of security.

Progressive Web App (PWA)

Konoz includes built-in PWA support, allowing your customers to install the platform as a native-like app on their mobile
devices. Enable this feature from the PWA Settings tab to provide an app-store-quality experience without the app-store

submission process.

Konoz Settings

Konaz Intermal System Notice: This system creates intemal digital accounts for use within your platform oy These are NOT payment cards and cannot be used for extemal purchases

General Settings  PWASettings | Branding  Fraud Detection  Payment Gateway  About & Support
Enable PWA ) Enable Progressive Web App features
App Name digital-finance-management-system

Virtual Cards pr——y—

Financial
User Management

Communications

B System Settings

» Appearance

% Plugins

Figure 5.3 — PWA settings enable customers to install Konoz as a mobile app for convenient, always-available access.

TIP — PWA BEST PRACTICE
When enabling PWA mode, set a clear, concise app name (e.g., "MyBank" rather than “MyBank Financial Services Platform”)
that displays well on mobile home screens. Test the installation flow on both iOS (Safari > Share > Add to Home Screen) and
Android (Chrome > Install App) to ensure a smooth experience for all customers.



Fraud Detection & Security

Protecting your platform and your customers is paramount. Konoz includes an intelligent fraud detection engine that monitors
transactions for suspicious patterns. Enable it from System Settings > Fraud Detection.

- ' - -~

Konoz Settings

| Konoz Internal System Notice: This system s internal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for external purchases.

General Settings  PWASettings  Branding  Fraud Detection ~ PaymentGateway  About & Support

Fraud Detection ISA

fraud detection for all transactio
B Virtual Cards

] Financial Products

@ User Management

3 Communications
About Fraud Detection

B System Settings

# Appearance

¢ Plugins

fechnoloy

Figure 5.4 — The Fraud Detection panel provides five configurable detection rules to protect your platform.

DETECTION RULE WHAT IT MONITORS RECOMMENDED CONFIGURATION
Velocity Check Rapid consecutive transactions indicating automated Threshold: 5 transactions/minute; Action: Block + Alert
fraud
Amount Anomaly Unusually large amounts relative to account history Flag transactions exceeding 3x the account'’s average
Time Pattern Transactions at unusual hours (e.g., 2-5 AM local Enable alerts; review flagged transactions next
time) business day
Recipient Pattern Transfers to new or unverified recipients Require additional verification for first-time recipients
Geographic Sudden IP address location changes Temporarily suspend account and notify the customer
Anomaly

Communications Management

Effective communication builds trust. Konoz provides a comprehensive communications suite to keep your customers
informed and engaged. Access it via Communications in the admin sidebar.

MODULE PURPOSE KEY SETTINGS

SMS Settings Automated SMS notifications Provider (Twilio, Nexmo, Custom), API credentials, notification types
Announcements Broadcast messages to all accounts Create, schedule, and manage platform-wide announcements
Auto-Statements Automatic account statement delivery Frequency (monthly/weekly), format, inactive account handling
Balance Alerts Low balance notifications Threshold amount, delivery method (email/SMS), alert frequency



Security Best Practices

Beyond the built-in fraud detection, implement the following security measures to maintain the highest level of platform

integrity. These recommendations align with industry standards for financial service platforms.

Keep Software Updated: Regularly update WordPress core, Konoz, and all plugins to patch security vulnerabilities. Test
updates in Sandbox mode first.

Enforce Strong Passwords: Require complex, unique passwords for all admin and staff accounts. Minimum 12
characters with mixed case, numbers, and symbols.

Enable Two-Factor Authentication: Activate 2FA for all administrative users using the [dfms_2fa_setup] shortcode. >
See Chapter 12 for shortcode details.

Monitor Fraud Alerts: Review Fraud Detection alerts and the System Wallet ledger daily for anomalies.
Maintain Regular Backups: Implement daily database backups with at least 30 days of retention and off-site storage.

Use SSL/HTTPS: Ensure your site uses an SSL certificate for all encrypted communications. This is mandatory for
payment gateway integration.

Audit Permissions Regularly: Review staff permissions weekly to ensure least-privilege access. - See Chapter 4 for

permission details.

@ Part IT Summary

KEY TAKEAWAYS WHAT YOU CAN DO NOW

e The System Wallet is the financial backbone — keep it funded o Configure branding, payment gateways, and communications

and monitored daily @ Set up staff roles with appropriate permission levels
Sandbox mode provides risk-free testing; Production requires e Enable all five fraud detection rules with recommended
payment gateways thresholds

Granular role-based permissions protect sensitive operations (6 ¢ Process your first customer registration and KYC approval
permission groups) @ Proceed to Part Ill to explore the customer-facing experience
KYC verification ensures regulatory compliance with a 4-step

auditable workflow

Five fraud detection rules provide intelligent, configurable

transaction monitoring
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The Customer Experience

The true measure of any financial platform is the experience it delivers to its customers. Part Il explores the elegant,
intuitive interfaces that Konoz provides to your end users — from their personal dashboard to transaction management,
fund transfers, and intelligent expense tracking.

CHAPTER 6

The Customer Dashboard

The Customer Dashboard is the first thing your users see when they log in, and it sets the tone for their entire experience.
Designed with clarity and purpose, it presents a comprehensive financial overview that enables users to take immediate
action. Deploy it on any WordPress page using the [dfms_transactions] shortcode. > See Chapter 12 for all available

shortcodes.

Dashboard

Good Evening, SALAH.ALMARDI! Thursda

Available Balance

@ $98,000.00 = ! D' ®

A/C: ACCABA24D3E@3

Quick Actions Recent Transactions View All
Expenses Manager Cards Loans DPS
- ed T -$2,000.00
a
i < bwenee -$6,000.00
FOR Transfer .

B o Detursement +$50,000.00

[ Cxd foprved +$15,000.00

Figure 6.1— The Customer Dashboard provides a complete financial overview with quick access to all services, recent transactions, and product
summaries.

The dashboard is organized into clear, purposeful sections that guide the user naturally through their financial world:
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SECTION

Balance & Account
Product Summary
Quick Actions

Recent Transactions

WHAT IT SHOWS

Available balance with account number

Active Cards, Active Loans, Pending Requests

One-tap access to Expenses, Cards, Loans, DPS, FDR, Transfer

Latest transactions with type, description, and amount

USER BENEFIT

Instant financial awareness at a glance
Quick status check across all products
Reduces navigation friction to zero

Immediate visibility into recent activity

¥ USE CASE — DIGITAL WALLET FOR GIG WORKERS

A ride-sharing cooperative deploys Konoz to provide drivers with personal financial dashboards. Each driver logs in to see their
earnings balance, recent trip payments, and quick access to transfer funds to their bank. The dashboard’s clean design means
even drivers with limited tech experience can manage their finances independently, reducing support calls by 70% and
increasing driver satisfaction scores by 45%.

TIP — DASHBOARD CUSTOMIZATION

The Quick Actions grid on the customer dashboard automatically reflects the products you have configured. If you have not
created any loan templates, the “Loans” quick action will not appear. This means you can start with a simple wallet-and-
transfer platform and gradually add products as your business grows — the dashboard adapts automatically.

CHAPTER 7

Effortless Transaction Management

Transaction History

Every financial activity within Konoz is recorded in a detailed, searchable transaction ledger. Customers access their
complete history through the frontend, with powerful filtering and export capabilities that support personal record-keeping
and tax preparation.

Transactions

Transaction History
View your recent account activity

Date Type Description Amount Balance Status

Feb 12, 2026 5:08 PV Dps Deposit DPS initial deposit - DPS1770916128514¢ -$1,000.00 $97.000.00 Completed
Fi 2, 2026 4:52PM Card Expense « +898 +$300.00 $98,000.00 Completed
Feb12, 2026 4:51PM Expense Education +$2,000.00 $98.000.00 Compieted
Feb 12, 2026 4:48 P Card Expense Card Exp 1g - House Rent (Card « + + + 8 398 +$6,000.00 $100.000.00 Completed
Feb12, 2026 ' PM Loan Disbursement Loandisbursement - LNO000O1 +$50,000.00 $100.000.00 Completed
Feb12, 2026 PM Card Approved Mast $15.000.00 +$15,000.00 $50,000.00 Completed

Figure 71 — The Transaction History view provides a complete, filterable record of all financial activities with type, amount, balance, and status.



Each transaction record includes the date, type (deposit, withdrawal, transfer, payment, loan disbursement), description,
amount, resulting balance, and status. Users can filter by transaction type, date range, or search term, and export their
complete history as a CSV file for import into personal accounting software or tax preparation tools.

The Admin Transaction Ledger

On the administrative side, the Transactions section (Konoz > Transactions) provides a centralized ledger of all financial
activities across the entire platform. Administrators can filter by transaction type, date range, or specific account to quickly
locate and audit any transaction.

Create Transfer

From User *

Jane Doe ~v

From Account *

ACCT2A53428C7 (Balance: $15000.00) v
To User *

Sob Wilson v
To Account *

ACCTBC64C1DB (Balance: $8400.00 v

Figure 7.2 — The admin Fund Transfers view tracks all inter-account transfers with full audit details including sender, recipient, amount, and
timestamp.

Sending Money: The Transfer Experience

Konoz makes sending money between accounts effortless. The Transfer Money interface is designed for speed and
simplicity, allowing users to send funds in just a few taps.

© 2025 Realms Information Technology — All rights reserved \ https://konoz.it-realms.com
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Transfer Money

Send money instantly to any Konoz account

0Z accou
Send Money

Send To

s \

2), Saved Beneficiary (¢ Enter Manually

< J

Select Beneficiary

s N

John
Change
ACCTBATASE7F

\ J

Amount

s 100

$50 $100 $250 $500

Note (Optional)

What's this for?

Figure 7.3 — The Transfer Money interface enables instant fund transfers with saved beneficiaries, quick-select amounts, and optional notes.

their account number.

amounts.

Add context: Optionally add a note describing the purpose of the transfer (e.g., “Rent payment — March 2025").

Confirm and send: Tap Send Money to complete the transfer instantly. Both sender and recipient receive confirmation
notifications.

TIP — BENEFICIARY MANAGEMENT

Encourage your customers to save frequent recipients as beneficiaries. This not only speeds up future transfers but also
reduces the risk of errors from manually entering account numbers. Beneficiaries can be managed via the
[dfms_beneficiaries] shortcode on a dedicated page.

CHAPTER 8

Intelligent Expense Management

Choose a recipient: Select from Saved Beneficiary for trusted contacts or Enter Manually for new recipients by entering

Enter the amount: Type a custom amount or use the quick-select buttons ($50, $100, $250, $500) for common transfer

The integrated Expenses Manager goes beyond simple transaction tracking, offering sophisticated features for
categorization, analysis, and proactive budgeting. It transforms passive financial data into actionable insights that help your
customers take control of their spending.

i NOTE — PAYMENT FLEXIBILITY

When logging an expense, customers can choose to pay using either their wallet balance or an issued Virtual Card, providing
maximum flexibility. This dual-payment capability is unique to Konoz and enables precise tracking of spending across payment
methods. - See Chapter 9 for virtual card details.
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Track, Analyze, and Control Your Spending

The Analytics tab within the Expenses Manager provides a rich, visual breakdown of spending habits. Users can see their
total spending for the current month, the number of categories they have spent in, and their top spending category — all at a

glance.
Expenses Manager

Expenses Manager

Track expenses, set budgets, and manage your finances

§ Expenses ul Budgets i Analytics Alerts # Scheduled

$18,900.00 5 Honsin.g

Wl Spending by Category % Category Breskdown
® Housing $13,000.00
® Entertainment $3,500.00
® Other $2,000.00
® Food and Dining $300.00
® Shopping $100.00

Figure 8.1— The Analytics tab provides a visual breakdown of spending by category with a dynamic donut chart and detailed category breakdown
table.

A dynamic donut chart and a detailed category breakdown table provide deep insights into where money is going, helping
users make smarter financial decisions and identify areas where they can save. Categories are color-coded for instant visual
recognition, and the percentage breakdown makes it easy to see which categories dominate spending.

Smarter Spending with Budgets

The Budgets tab transforms the Expenses Manager from a tracking tool into a proactive financial planning assistant. Users
set monthly, quarterly, or yearly budgets for any spending category. The system then automatically tracks spending against
these budgets, providing a real-time progress bar.

Expenses Manager

Expenses Manager
Track expenses, set budgets, and manage your finances

§ Expenses ™ Budgets #~ Analytics Alerts % Scheduled

Wl Set New Budget

Categeey Budget Amount Period

v e o v

& Active Budgats

‘ Food and Diring $300.00 55000

Figure 8.2 — The Budgets tab lets users set spending limits by category and track progress with color-coded bars (green/amber/red).

Set a New Budget: Select a spending category, enter the budget amount, and choose the period (Monthly, Quarterly, or
Yearly).

Monitor Progress: Active budgets display a color-coded progress bar — green (under 70%), amber (70-90%), and red
(over 90%) — showing current spending against the limit.

‘ Receive Alerts: The system notifies users when they approach or exceed their budget thresholds, enabling proactive
spending adjustments before overspending occurs.
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Administrative Expense Oversight

Administrators manage expense categories, set default budgets, and monitor platform-wide spending patterns from the

admin panel at Konoz > Expenses Manager. This provides valuable aggregate insights into how your customer base

manages their finances.

Add Manual Expense

Payment Source

| Wallet (Balance: $100,000.00) v
Wallet (Balance: $100,000.00)
Card ---- 8984 (Available: $15,000.00)
Housing

Amount

v

Figure 8.3 — The admin Expenses Manager interface for managing categories, default budgets, and platform-wide expense oversight.

¥ USE CASE — EMPLOYEE EXPENSE CONTROL

quarter.

@ Part III Summary
KEY TAKEAWAY'S

e The Customer Dashboard provides an intuitive, at-a-glance
financial overview with quick actions

e Transaction history is fully searchable, filterable, and
exportable to CSV

e Money transfers support both saved beneficiaries and manual
entry with instant confirmation

@ The Expenses Manager combines tracking, analytics (donut
charts), and budgeting (progress bars)

e Budget alerts create a proactive financial management
feedback loop for customers

A mid-sized consulting firm uses Konoz to issue virtual cards to employees for business expenses. Each employee’s Expenses
Manager is pre-configured with category budgets: $500/month for meals, $200/month for transport, and $1,000/month for
client entertainment. Managers receive automated alerts when any employee approaches their limit, enabling proactive cost
control without manual spreadsheet tracking. The firm reports a 25% reduction in discretionary spending within the first

WHAT YOU CAN DO NOW

o Configure expense categories with colors and icons for your
platform

o Set up default budget templates for common spending
categories

o Test the complete transfer flow using demo accounts

# Login as a demo user to experience the customer dashboard
firsthand

o Proceed to Part IV to discover Konoz's financial product suite

© 2025 Realms Information Technology — All rights reserved \ https://konoz.it-realms.com
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PART |V

Innovative Financial Products

Part IV showcases the heart of Konoz's revenue-generating capabilities: its suite of sophisticated financial products. This
is where you transition from providing basic wallet services to offering a comprehensive portfolio of modern financial
solutions — virtual cards, flexible loans, and structured savings instruments.

CHAPTER 9

The Power of Virtual Cards

Virtual cards allow you to issue branded, configurable debit and credit cards to your customers — entirely within the digital
ecosystem, with no physical card production required. They represent one of the most compelling revenue and engagement
features of the Konoz platform, enabling you to generate recurring revenue through annual fees while providing customers
with a modern spending instrument.

Creating Card Templates

Before customers can apply for cards, administrators must create Card Templates that define the types of cards available.
Each template specifies the card’s characteristics, eligibility requirements, and financial parameters. Think of templates as
your card product catalog — you might offer a free basic card, a mid-tier silver card with moderate limits, and a premium gold
card with high limits and cashback rewards.

lempiates aernne uie lypes Ol Caras avalliapie 10r appuicauori.

LS Card Templates Management

Posts

Konoz Internal System Notice: This system creates intemnal digital accounts for use within your platform only. These are NOT payment cards and cannot be used for extemal purchases.

%) Media

Create and manage card ter

tomers can apply for
Pages

Comments

fl Konoz Add New Template Existing Card Templates

& Ssystem Wallet

Figure 9.1 — The Card Templates management page where you define the card products available to your customers.

TEMPLATE FIELD DESCRIPTION EXAMPLE

Template Name

Card Type
Annual Fee
Spending Limit
Minimum Salary
Cashback Rate

Card Color

Display name customers see when applying
Visa or Mastercard branding

Yearly fee for card ownership

Maximum transaction or balance limit

Income requirement for eligibility

Percentage cashback on qualifying transactions

Visual customization for card appearance

Visa Gold

Visa

$50 (or $0 for basic tier)
$25,000

$3,000/month

2%

Gold (#c9a84c)
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The Virtual Card Lifecycle

Understanding the complete lifecycle of a virtual card helps you manage the process efficiently. The diagram below
illustrates every stage from template creation through active use to eventual renewal or closure.

Admin Creates Card Template

Customer Applies for Card

Approved Rejected

Card Issued & Activated

Application Denied

Set Spending Limits

Make Purchases & Payments

Active

Expired

Renewal or Closure

Figure 9.2 — The complete virtual card lifecycle from template creation through application, approval, payment, issuance, and active use.

Processing Card Applications

When a customer applies for a virtual card through the frontend ( [dfms_apply_card] shortcode), the application appears in
Virtual Cards > Card Applications for administrative review.

‘ Review the application: Verify the customer’s eligibility against the card template requirements (minimum salary,
account status, KYC completion).

‘ Approve or Reject: Click Approve to proceed or Reject with a documented reason.

‘ Payment Processing: If the template has an annual fee, the system automatically sends a payment link to the customer
via the configured payment gateway.
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@ Card Issuance: Upon payment confirmation (or immediately for free cards), the virtual card is issued and becomes
visible in the customer’s My Cards section ( [dfms_my_cards] ).

Managing Active Cards

The All Cards section (Virtual Cards > All Cards) provides a complete view of every issued card on the platform. Each card
displays the masked card number, cardholder name, expiry date, spending limit, current spending, and status. Administrators
can view details, block/unblock cards, or delete them as needed.

¥ USE CASE — CORPORATE EXPENSE CARDS

A technology startup issues Konoz virtual cards to each department head with tailored spending limits: $5,000/month for
Engineering, $3,000/month for Marketing, and $2,000/month for Operations. The CFO monitors all card spending from the
admin dashboard in real time. When the Marketing team needs a temporary limit increase for a product launch event, the admin
adjusts the template instantly — no bank calls, no paperwork, no delays.

? FREQUENTLY ASKED

Can a customer hold multiple virtual cards? Yes. A customer can apply for and hold multiple cards from different templates

simultaneously. For example, a user might have a basic card for everyday spending and a premium card for travel expenses,
each with its own spending limit and cashback rate.

CHAPTER 10

Flexible Lending Solutions

Konoz's lending module transforms your platform into a full-service lending institution. From personal loans to business
financing, you can design, offer, and manage a complete portfolio of loan products with automated EMI (Equated Monthly
Installment) calculations and repayment tracking.

Designing Loan Templates

Loan Templates define the products available to your customers. Each template specifies the financial parameters, eligibility
criteria, and required documentation. Consider creating multiple templates for different customer segments — a short-term
personal loan, a medium-term business loan, and a long-term mortgage product.

[ IR  MAS T IS LI NS LAY LATILARS IS IS A [ A e s

® Loan Templates [ #ssnew

| Konoz Intemai System Notice: This system creates intemal digital accounts for use within your platform ondy. These are NOT payment cards and cannct be used for extemal purchases

| 1o et ot s s s cam ey o cm e o

o=

Figure 10.1 — The Loan Templates page where you configure your lending products with rates, tenure ranges, and eligibility criteria.
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TEMPLATE FIELD DESCRIPTION

Category Name Product name visible to customers
Min/Max Amount Allowable loan amount range
Min/Max Tenure Repayment period range in months
Interest Rate Annual interest rate

Processing Fee One-time fee at disbursement
Minimum Income Income requirement for eligibility

Required Documents Documents the applicant must provide

The Customer Loan Application Experience

EXAMPLE

Personal Loan
$1,000 - $50,000

3 - 36 months

8.5%

1.5% of loan amount
$2,000/month

ID, Income Proof, Address Proof

Konoz provides an intelligent, guided loan application process on the frontend. The system validates eligibility in real time and

calculates EMI details before the customer submits their application, ensuring full transparency and building trust.

Apply for Loan

Loan Amount ($) * Tenure (months) *

70000 15

Monthly Income ($) * Employment Status *

sod ¢ SelectStatus

AWARNING. 0 $2.000)

Purpose (Optional)

€11 us why you need this loan (optional)

Figure 10.2 — The loan application form validates income requirements in real time, alerting users when they do not meet the minimum threshold.

Apply for Loan
Auto Loan
Loan Amount ($) * Tenure (months) *
70000 15
Monthly Income (S) * Employment Status*
5000 Select Status

¥ Succezs! You meet the Income requiremant (Minimur: $2.000)

Purpose (Optional)

Figure 10.3 — Upon meeting eligibility, the EMI calculator shows monthly payment, total interest, and total payable amount before submission.
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A IMPORTANT — TRANSPARENT LENDING
The EMI calculation is performed transparently before submission, so customers always know their exact monthly obligation.
This transparency builds trust and reduces loan defaults caused by unexpected payment amounts. The calculation uses the

standard reducing-balance EMI formula: EMI = P x r x (1+r)" / ((1+r)" = 1), where P is the principal, r is the monthly interest rate,
and n is the tenure in months.

The Loan Lifecycle

From application to final repayment, every loan follows a structured, auditable lifecycle. The diagram below illustrates the
complete process, including the critical disbursement step that draws from the System Wallet.

Admin Creates Loan Template

Customer Submits Application

Approved Rejected

Loan Disbursed to Wallet Application Denied

EMI Schedule Generated

Monthly Installment Due

Paid on Time Overdue

Installment Recorded

i

Figure 10.4 — The complete loan lifecycle from application through review, approval, disbursement, EMI payments, and closure.
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Processing and Managing Loans

Administrators manage loans through Loans > All Loans. The processing workflow follows a clear sequence:

Review the Application: Examine the applicant's details, income verification, and submitted documents.

Approve or Reject: Click Approve to accept or Reject to decline with a documented reason.

Track Repayments: Monitor the EMI schedule and click Mark as Paid as installments are received.

Loan Details

Loan Number:

Loan Type:

Duration:

Interest Rate:

Status:

Disbursed On:

Customer Details

LN0000O1

Auto Loan

15 months

12.50% per annum

ACTIVE

November 29, 2025

Name:

Figure 10.5 — The admin Loan Details view shows the complete EMI schedule with payment tracking, outstanding balance, and next due date.

The Customer Loan View

Customers monitor their active loans from the frontend, seeing their outstanding balance, EMI progress, and upcoming

Salah

# Due Date

1 Dec 01, 2025

2 Jan 01, 2026

3 Feb 01, 2026

4 Mar 01, 2026

5 Apr 01, 2026

6 May01,2026

7 Jun 01, 2026

8 Jul 01, 2026

9 Aug 01, 2026

payment schedule with convenient Pay Now buttons for each installment.

Loan #1

Auto Loan

Lowa

$70,000.00

Progress

o

EMI Payment Schedule

1 Dec 01,2025

2 Jan 01,2026

3 Feb 01, 2026

4 Mar 01, 2026

5 Apr 01, 2026

6 May01,2026

7 Jun 01, 2026

Figure 10.6 — The customer loan view displays progress, outstanding balance, and the complete EMI schedule with Pay Now buttons.

ouTSTMDING

$69,870.08

$5,064.96
$5,064.96
$5,064.96
$5,064.96
$5,064.96
$5,064.96

$5,064.96

T EM

$5,064.96

TeRe:

12.50%

Amount  Status

$5.064.96

$5.064.96

$5.064.96

$5,064.96

$5.06496  Pending

$5.06496  Pending

$5.064.96

$5.064.96

$5.064.96  Pending

sTRATE

2/15 EMIs paid

Nov 29, 2025

Nov 29, 2025

3

i

Action

Loan #LN0000O1 x
PRINCIPAL AMOUNT MONTHLY EMI
$70,000.00 $5.064.96
Loan Information EMI Payment Schedule
a
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Disburse Funds: For approved loans, click Disburse to transfer funds from the System Wallet to the borrower's account.
The EMI schedule is automatically generated. - Ensure the System Wallet has sufficient funds (Chapter 3).
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LOAN STATUS MEANING ADMIN ACTION

Pending Application submitted, awaiting review Review and approve/reject

Approved Accepted, awaiting disbursement Click Disburse to release funds

Active Funds disbursed, EMI repayments in progress Monitor and mark payments as received
Completed All installments paid, loan closed No action required

Rejected Application declined Provide reason to customer

Defaulted Repayments significantly overdue Initiate recovery process

¥ USE CASE — SME WORKING CAPITAL LOANS

A business association uses Konoz to offer short-term working capital loans to its member businesses. A restaurant owner
applies for a $15,000 loan with a 6-month tenure to purchase kitchen equipment. The association’s finance team reviews the
application, approves it within 24 hours, and disburses funds directly to the owner's Konoz wallet. The automated EMI schedule
ensures consistent repayment tracking, and the restaurant owner monitors their balance and upcoming payments from their
phone.

CHAPTER 11

Building Wealth: DPS & FDR

Konoz extends beyond transactions and lending to offer wealth-building products that help your customers grow their
savings. The Deposit Pension Scheme (DPS) and Fixed Deposit Receipt (FDR) provide structured savings and investment
options with guaranteed returns.

Deposit Pension Scheme (DPS)

DPS is a recurring deposit product where customers make regular monthly deposits over a fixed term and earn interest on
their accumulated savings. It is ideal for customers who want to build savings discipline with a predictable outcome — similar
to a systematic savings plan or recurring deposit.

Creating DPS Plans

Administrators create DPS plans from Financial Products > DPS. Each plan defines the monthly deposit range, duration,
interest rate, and maturity amount formula. Consider offering multiple plans at different deposit levels to serve various
customer segments — for example, a “Starter Saver” plan with $50-$200/month deposits and a “Wealth Builder” plan with
$500-$5,000/month deposits.

The Customer DPS Application

Customers apply for DPS through the frontend ( [dfms_dps] shortcode), where they select a plan, enter their desired
monthly installment, and instantly preview their maturity outcome.
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Apply for DPS

Apply for DPS

Deposit Pension Scheme — Save monthly, earn more!

Select 2 Plan

DPS 3 Years

Monthy installment Amount

Amount ($)

Enter manthly amount

Figure 11.1 — The DPS application form lets customers select a plan and enter their monthly deposit amount.

Apply for DPS

Deposit Pension Scheme — Save monthly, earn more!

Select a Plan

DPS 3 Years

Ouraton
irterest Rate:
Monthly Range $900- 550000

Monthly Installment Amount

Amount ($)
[ s :
Maturity Preview
Tl D c W
$18000.00 +$4590.00 $22590.00

Figure 11.2 — The Maturity Preview instantly shows total deposits, interest earned, and the final maturity amount before submission.

Managing Active DPS Accounts

Customers view their active DPS accounts, track installment progress, and make payments from the My DPS section.

My DPS

My DPS Accounts
PR e $1,000.00 Montgyatmen: $1,000.00
o0 12 months P 12 months
rearest Rate 7.50% rerest Rate 7.50%
Maturity Amount $12,900.00 Maturity Amount $12,900.00
Prograss 112 instabmants 112 instaliments
e

- —

Figure 11.3 — The My DPS view shows active accounts with installment progress, payment history, and upcoming due dates.
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Administrators manage DPS accounts from the admin panel, where they can view installment schedules, mark payments as
received, and process maturity payouts when the term completes. Maturity payouts are drawn from the System Wallet. -

Ensure sufficient System Wallet balance (Chapter 3).

Fixed Deposit Receipt (FDR)

FDR is a one-time deposit product with a fixed tenure and guaranteed return. Customers deposit a lump sum and receive
their principal plus interest at maturity. It is the ideal product for customers with available capital who seek a safe, predictable
return — similar to a certificate of deposit or term deposit.

Creating FDR Plans

Administrators create FDR plans from Financial Products > FDR. Each plan specifies the minimum and maximum deposit
amounts, tenure options, and the interest rate. Offer tiered rates to incentivize larger deposits — for example, 5% for deposits
under $10,000 and 7% for deposits above $10,000.

Customer FDR View

Customers monitor their active FDR accounts, seeing their deposit amount, interest rate, earned interest, maturity amount,
and days remaining until maturity.

My FDR

My FDR Accounts

e e
Deposit Amount $1'00000 Deposit Amount $1’000.00
el 12 months Ruen 12 months
7.00% 7.00%
+$70.00 +$70.00
Maturity Amount $1,070.00 Maurty Amount $1,070.00

Matures in Matures in

363 days 363 days

Jan 30, 2027 Jan 30, 2027

Figure 11.4 — The My FDR view displays active deposits with interest earned, maturity amount, and countdown to maturity date.

i NOTE — EARLY WITHDRAWAL

FDR accounts support early withdrawal with a configurable penalty (e.g., forfeiting 50% of earned interest). This provides
customers with liquidity flexibility while protecting the platform'’s financial planning. Clearly communicate penalty terms in your
platform'’s terms of service and during the application process to set proper expectations.

% USE CASE — COMMUNITY SAVINGS PLATFORM

A community development organization launches a savings platform using Konoz. Members choose between DPS (for those
who can save $100/month) and FDR (for members with lump-sum savings from seasonal income). After one year, DPS
members have accumulated savings with 8.5% interest, while FDR members earn guaranteed 7% returns. The organization
reports a 40% increase in member savings rates compared to their previous manual ledger system.
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@ Part IV Summary
KEY TAKEAWAYS

o Virtual cards can be issued instantly with customizable
templates, spending limits, and cashback

e The lending module provides end-to-end loan management
with automated EMI tracking

o Real-time eligibility validation and EMI calculation build
customer trust

e DPS offers disciplined recurring savings; FDR offers lump-sum
fixed returns

e All financial products follow clear, auditable lifecycles with
admin oversight

WHAT YOU CAN DO NOW

o Create card templates for different customer segments (basic,
gold, platinum)

o Design loan products with appropriate rates and eligibility
criteria

o Configure DPS and FDR plans to attract savers and investors

o Test the complete application-to-issuance flow for each
product

e Review the Product Comparison table in the Reference section

© 2025 Realms Information Technology — All rights reserved \ https://konoz.it-realms.com
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[kono_finance_widget]

Portfolo o

PART V

Building Your Vision

With a deep understanding of Konoz's capabilities, it is time to bring your vision to life. Part V provides the practical tools
to integrate Konoz into your website, guides you through common operational workflows, and equips you with
troubleshooting knowledge to keep your platform running smoothly.

CHAPTER 12

Shortcodes: Weaving Konoz into Your Website

Shortcodes are the primary method for integrating Konoz functionality into your WordPress pages. Each shortcode embeds a
specific Konoz feature — from the customer dashboard to loan applications — directly into any page or post. Simply add the
shortcode to a WordPress page, and the corresponding Konoz interface renders for your customers.

How to Use Shortcodes

ﬂ Edit the desired WordPress page where you want to embed a Konoz feature.

a Add a Shortcode block (or paste directly into the editor in a Custom HTML block).
a Enter the shortcode exactly as shown in the tables below (e.g., [dfms_my_cards] ).

o Publish or update the page to make the feature live for your customers.

TIP — APP-LIKE NAVIGATION

Create a dedicated page for each major feature (e.g., "My Cards,” “Apply for Loan,” "Expenses”) and add the corresponding
shortcode. Then link these pages in your site's navigation menu for a seamless, app-like experience. Combined with PWA mode
(Chapter 5), this creates a native-app feel without any app store submission.

Complete Shortcode Reference

Account & Dashboard

SHORTCODE FUNCTION TYPICAL PAGE
[dfms_transactions] User's transaction list and dashboard Dashboard / Home
[dfms_transaction_history] Detailed transaction history with advanced filters Transaction History
[dfms_statements] Account statements view and download Statements
[dfms_analytics] Financial analytics dashboard with charts Analytics
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Money Movement

SHORTCODE
[dfms_transfer]
[dfms_quick_transfer]
[dfms_beneficiaries]
[dfms_deposit]
[dfms_withdrawall]

[dfms_scheduled_payments]

Cards & Loans

SHORTCODE
[dfms_my_cards]
[dfms_apply_card]
[dfms_Tloans]

[dfms_apply_loan]

Savings & Investments

FUNCTION

Full transfer money form with beneficiary selection
Compact quick transfer widget

Manage saved beneficiaries (add, edit, delete)
Deposit funds form (via payment gateway)
Withdrawal request form

Manage scheduled and recurring payments

FUNCTION

Display the user's issued virtual cards
Virtual card application form

Display active loans with EMI details

Loan application form with EMI calculator

SHORTCODE FUNCTION
[dfms_dps] Display DPS accounts with installment tracking
[dfms_fdr] Display FDR accounts with maturity details

User Preferences & Security

SHORTCODE
[dfms_2fa_setup]
[dfms_alert_preferences]
[dfms_statement_preferences]

[dfms_sms_settings]

General & Administrative

SHORTCODE
[dfms_kyc]
[dfms_register]
[dfms_currency_converter]
[dfms_expenses_manager]
[dfms_payment_page]

[dfms_admin_stats]

FUNCTION

Two-factor authentication setup interface
Balance alert configuration

Statement delivery preferences

SMS notification preferences

FUNCTION

KYC document submission form
Customer registration form
Currency conversion tool

Full Expenses Manager interface
Payment processing page

Admin statistics display (authorized users only)

TYPICAL PAGE
Transfer Money
Dashboard sidebar
Beneficiaries

Add Funds
Withdraw

Scheduled Payments

TYPICAL PAGE
My Cards
Apply for Card
My Loans

Apply for Loan

TYPICAL PAGE
My DPS

My FDR

TYPICAL PAGE
Security Settings
Alert Settings
Statement Settings

Notification Settings

TYPICAL PAGE
Verify Identity
Register / Sign Up
Tools

Expenses
Payment

Admin Dashboard

3
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CHAPTER 13

Common Workflows & Best Practices

This chapter brings together the knowledge from previous chapters into practical, end-to-end workflows that you will

perform regularly. Each workflow is presented as a numbered sequence with cross-references to the detailed chapters for

deeper context.

Workflow 1: Processing a Customer Registration

The customer submits a registration application via the [dfms_register] shortcode on your website.
Navigate to User Management > Registration in the admin panel. - Chapter 4

Click View on the pending application to review personal information and KYC documents.

Verify that the ID photo matches the selfie and the address proof is current (within 3 months).

Click Approve KYC Documents to verify the customer. The system automatically creates a WordPress user account,
generates credentials, creates a wallet, and records the KYC verification.

Alternatively, click Reject KYC to decline with a stated reason. The customer may resubmit.

A COMMON MISTAKE

Approving KYC documents without carefully verifying that the ID photo matches the selfie, and that the address proof is current

(within 3 months). Thorough document review is essential for regulatory compliance and fraud prevention. A single oversight
can expose your platform to identity fraud liability.

Workflow 2: Issuing a Virtual Card

The customer applies for a card via the [dfms_apply_card] shortcode. - Chapter 9

Navigate to Virtual Cards > Card Applications in the admin panel.

Review the application against template eligibility requirements (minimum salary, KYC status).

Click Approve to accept the application.

If the card template has an annual fee, the system automatically sends a payment link to the customer.

Upon payment confirmation (or immediately for free cards), the card is issued and appears in the customer's
[dfms_my_cards] view.
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The customer applies for a loan via [dfms_apply_loan] , with real-time eligibility validation and EMI calculation. -
Chapter 10

Navigate to Loans > All Loans in the admin panel.
Review the application: income verification, requested amount, tenure, and submitted documents.
Click Approve to accept the loan application.

Verify the System Wallet has sufficient funds, then click Disburse to transfer funds to the borrower’s account. The EMI
schedule is automatically generated. - Chapter 3

Monitor repayments through the loan detail page and click Mark as Paid as installments are received.
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A IMPORTANT — DISBURSEMENT PREREQUISITE

Always verify that the System Wallet has sufficient funds before disbursing a loan. If the wallet balance is lower than the loan
amount, the disbursement will fail. Maintain a buffer of at least 20% above your expected daily disbursement volume to avoid
operational disruptions. > See Chapter 3 for wallet management.

Workflow 4: Opening a DPS or FDR Account

a The customer selects a DPS plan via [dfms_dps] oran FDR plan via [dfms_fdr] and submits their application. >
Chapter 11

Navigate to Financial Products > DPS or FDR in the admin panel.
Review and approve the application.

For DPS: Monitor monthly installment payments and mark them as received. Process the maturity payout when the term
completes.

For FDR: Monitor the deposit until maturity. Process the maturity payout (principal + interest) or handle early withdrawal
requests with the configured penalty.

Best Practices for Platform Operations

PRACTICE RECOMMENDATION FREQUENCY

Daily Monitoring Review the Main Dashboard for transaction volume, active accounts, and pending Daily
applications.

Wallet Management Maintain a buffer of at least 20% above expected daily disbursement volume in the Daily

System Wallet.

Application Process all pending registrations, card applications, and loan requests within 24 hours. Daily

Processing

Security Audits Review fraud detection alerts, failed login attempts, and permission assignments. Weekly

Communication Use Announcements to inform customers about new products, maintenance, or policy As needed
changes.

Backup Schedule Maintain daily database backups with at least 30 days of retention, stored off-site. Daily

(automated)
Software Updates Update WordPress core, Konoz, and all plugins. Test in Sandbox first. Monthly

CHAPTER 14

Troubleshooting & Support

Even the most robust platforms occasionally encounter issues. This chapter provides solutions to the most common problems
administrators face, enabling you to resolve issues quickly and minimize disruption to your customers.
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Common Issues and Solutions

ISSUE LIKELY CAUSE SOLUTION

Plugin pages return 404 Permalink settings Navigate to Settings > Permalinks, set to Post name, and save to flush
errors incorrect rewrite rules.

System Wallet shows Wallet balance too low Navigate to System Wallet and click Inject Capital (Sandbox) or verify
insufficient funds payment gateway deposits (Production). - Ch. 3

Cards not issued after Payment gateway Verify gateway credentials in System Settings (Ch. 5), ensure template is
approval misconfiguration Active, and confirm payment.

Loan disbursement failing Insufficient system funds Verify System Wallet balance exceeds loan amount, confirm loan status is

Approved, and ensure borrower’s account is Active.

Users cannot register Frontend form missing Verify the registration page contains [dfms_register] shortcode (Ch.
12). Check PHP error logs.

SMS notifications not Provider configuration Verify SMS credentials in Communications > SMS Settings (Ch. 5), check
sending issue provider balance, confirm phone format.

Shortcodes display as Plugin not activated or Verify Konoz is activated in Plugins menu. Clear page cache. Use

plain text cache Shortcode or Custom HTML block.

Payment gateway returns Invalid API credentials or Re-enter API credentials. Ensure HTTPS. Test with sandbox credentials
errors SSL first.

DPS/FDR maturity payout System Wallet insufficient Inject capital to cover the maturity amount. Plan wallet funding ahead of
fails maturity dates.

Debugging Techniques

When the troubleshooting table above does not resolve your issue, use these debugging techniques to identify the root
cause:

a Enable WordPress Debug Mode: Add define('WP_DEBUG', true); and define('WP_DEBUG_LOG', true); toyour wp-
config.php file. Check wp-content/debug.log for detailed error messages.

Check Browser Console: Open your browser's developer tools (F12) and check the Console tab for JavaScript errors
that may affect frontend functionality.

Test in Sandbox Mode: If the issue occurs in Production, attempt to reproduce it in Sandbox mode to isolate whether it is
a configuration or payment-related issue.

Deactivate Other Plugins: Temporarily deactivate other plugins to check for conflicts. Reactivate them one by one to
identify the conflicting plugin.

Verify Server Requirements: Confirm PHP 7.4+, WordPress 5.8+, and MySQL 5.7+ are running. Check PHP memory limit
(recommend 256MB+).

TIP — PRODUCTION DEBUGGING

Never leave WP_DEBUG enabled on a production site, as it can expose sensitive information to visitors. Enable it only during
active investigation, capture the relevant log entries, then disable it inmediately. Consider using a staging environment for
extended debugging sessions.

Gelting Support

If you encounter an issue not covered in this guide, the Konoz support team is ready to assist. Visit the official Konoz website
for documentation updates, community forums, and direct support channels:

42



https://konoz.it-realms.com

@ PartV Summary
KEY TAKEAWAYS

o 20+ shortcodes cover every feature from registration to
investments

e Create dedicated pages per feature for an app-like navigation
experience

WHAT YOU CAN DO NOW

o Create dedicated pages for each Konoz feature using
shortcodes

¢ Build a complete customer-facing navigation menu

e Four core workflows (registration, cards, loans, savings) follow

repeatable sequences

o Practice each workflow using demo data before going live

o Bookmark the troubleshooting table for quick reference

e Visit konoz.it-realms.com for updates and support

@ Proactive monitoring and 24-hour application processing are

operational best practices

e Most common issues have straightforward solutions in the

troubleshooting table

REFERENCE

Financial Products Comparison

The following table provides a side-by-side comparison of all financial products available in Konoz, helping you understand

the differences and choose the right products for your customer base.

DIMENSION VIRTUAL CARDS LOANS

Product Type Spending instrument Credit product

Customer Apply for a card Apply for a loan

Action

Fund Flow Customer - Spending System Wallet - Customer
Revenue Annual fee + cashback spread Interest + processing fee

Model

Admin Template > Review - Approve Template > Review - Approve >
Workflow - Issue Disburse - Track EMI

System Wallet
Impact

None (customer-funded)

Debit at disbursement

Frontend [dfms_my_cards] , [dfms_loans] ,
Shortcodes [dfms_apply_card] [dfms_apply_loan]
Key Risk Overspending beyond limits Loan defaults

Ideal Active spenders, employees Borrowers needing capital
Customer

TIP — PRODUCT STRATEGY

DPS

Recurring savings
Open a DPS account
Customer - Monthly
deposits

Interest margin on
deposits

Plan - Review -

Approve - Track -

Payout

Debit at maturity payout
[dfms_dps]

Missed installments

Disciplined savers

FDR

Fixed-term deposit
Open an FDR account
Customer - Lump-sum
deposit

Interest margin on
deposits

Plan - Review >
Approve - Monitor -

Payout

Debit at maturity payout

[dfms_fdr]

Early withdrawal
requests

Investors with lump
sums

Start with one or two products (e.g., Virtual Cards + Personal Loans) and expand your portfolio as your customer base grows.

This allows you to refine your operational workflows before adding complexity. Monitor the System Wallet impact of each

product type to maintain healthy liquidity.

REFERENCE
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Glossary of Key Terms

Beneficiary
A saved transfer recipient. Customers save beneficiaries to speed
up future transfers and reduce errors from manual account
number entry.

DPS (Deposit Pension Scheme)

A recurring deposit savings product where customers make
regular monthly deposits over a fixed term and earn interest on
accumulated savings.

EMI (Equated Monthly Installment)

A fixed monthly payment made by a borrower to repay a loan.
Includes both principal and interest, calculated using the
reducing-balance method.

FDR (Fixed Deposit Receipt)
A one-time deposit product with a fixed tenure and guaranteed
return. The customer deposits a lump sum and receives principal
plus interest at maturity.

Fraud Detection
An intelligent monitoring system analyzing transactions for
suspicious patterns using five configurable rules: Velocity Check,
Amount Anomaly, Time Pattern, Recipient Pattern, and
Geographic Anomaly.

KYC (Know Your Customer)

A regulatory compliance process verifying customer identity
before granting access to financial services. Involves reviewing
uploaded identity documents (ID, selfie, address proof).

Ledger Transaction
Any recorded financial activity in the system, including deposits,
withdrawals, transfers, loan disbursements, EMI payments, and
fee charges. Every ledger transaction is immutable and auditable.

REFERENCE

Frequently Asked Questions

Production Mode
The live operating mode where real financial transactions are
processed through configured payment gateways. Manual capital
injections are disabled to maintain financial integrity.

PWA (Progressive Web App)
A technology allowing web applications to be installed on mobile
devices like native apps, providing offline capabilities, push
notifications, and an app-like experience.

Sandbox Mode
A testing environment where all financial operations are simulated
with no real money. Manual capital injections are allowed, and
deposits are processed instantly without payment gateways.

Shortcode
A WordPress feature embedding dynamic content into pages
using a simple tag syntax (e.g., [dfms_my_cards] ). Konoz
provides 20+ shortcodes for all customer-facing features.

System Wallet
The central treasury of the Konoz platform. All financial
operations — loan disbursements, DPS/FDR maturity payouts,
and capital management — flow through this wallet.

Virtual Card
A digital payment card (Visa or Mastercard branded) issued
within the Konoz ecosystem. Features configurable spending
limits, annual fees, and cashback rates with no physical card
production.

Two-Factor Authentication (2FA)
An additional security layer requiring users to provide two forms
of identification before accessing their account, typically a
password plus a time-based code from an authenticator app.

Installation & Setup

Q: Can |l install Konoz on a shared hosting plan?

A: Yes, Konoz works on shared hosting as long as it meets the minimum requirements (PHP 7.4+, MySQL 5.7+, WordPress 5.8+).

However, for production financial operations, we recommend a VPS or managed WordPress host with dedicated resources for

better performance and security.

Q: Does Konoz support multiple currencies?

A: Konoz supports a single default currency per installation, configured in System Settings > General. You set the currency code

(e.g., USD, EUR, AED) and symbol, which applies across all financial operations. For multi-currency needs, you can use the built-in

currency converter shortcode ( [dfms_currency_converter] ) for reference rates.

Q: How do | update Konoz to a newer version?

A: Download the latest version from konoz.it-realms.com. Before updating, create a full backup of your database and files. Then

navigate to Plugins > Add New > Upload Plugin, upload the new ZIP file, and WordPress will offer to replace the existing version.

Always test the update in a staging environment first.
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Financial Operations

Q: What happens if the System Wallet runs out of funds?

A: If the System Wallet balance is insufficient, outbound operations (loan disbursements, DPS/FDR maturity payouts) will fail.
Customer-to-customer transfers are not affected, as they move funds between user wallets. Monitor your wallet daily and maintain
a buffer of at least 20% above expected daily disbursement volume.

Q: Can | customize the EMI calculation formula?

A: Konoz uses the standard reducing-balance EMI formula, which is the industry standard for transparent lending. The formula
parameters (principal, interest rate, tenure) are configurable per loan template. The formula itself is not customizable, ensuring
consistency and regulatory compliance across all loan products.

Q: How are virtual cards different from physical bank cards?

A: Konoz virtual cards are digital representations within the platform ecosystem. They track spending limits, cashback, and
balances within Konoz. They are not connected to external payment networks (Visa/Mastercard processing networks) for point-of-
sale transactions. They are ideal for internal expense tracking, corporate spending controls, and platform-native transactions.

Security & Compliance

Q: Is Konoz PCI-DSS compliant?
A: Konoz does not store or process actual credit card numbers. Payment processing is handled entirely by Stripe and PayPal,
which are PCI-DSS Level 1 certified. Konoz stores only transaction references and metadata, not sensitive payment card data. This
architecture significantly reduces your PCI compliance burden.

Q: Can | use Konoz for a regulated financial institution?
A: Konoz provides the technical infrastructure for financial operations. Regulatory compliance (licensing, reporting, capital
requirements) depends on your jurisdiction and business model. Consult with a financial regulatory advisor to ensure your use of
Konoz meets local requirements. The built-in KYC, audit trails, and fraud detection features support compliance efforts.
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Your Partner in Financial Innovation

You have now explored the full breadth of the Konoz Financial Operations &
Wallet Management System — from foundational setup to advanced financial
products, from administrative mastery to customer-facing elegance.

The tools are in your hands. The platform is ready. Whether you are building a
community savings platform, a corporate expense management system, a
microfinance institution, or a next-generation digital bank, Konoz provides the

infrastructure to turn your ambition into reality.

We are honored to be your partner on this journey.

Konoz is a financial operations and wallet management system developed by
Realms Information Technology.
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